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Abstract

This technical report (TR) introduces the reporting features that are available with NetApp®
OnCommand® Unified Manager for the NetApp clustered Data ONTAP® operating system.
Reporting features were introduced in OnCommand Unified Manager 6.2. This TR describes
in detail how to implement the reporting functionality within OnCommand 6.2 and 6.3. It also
describes how to manage and implement custom reports, including how to export and import
external reports. This TR also gives examples of reports and reference information for creating
native and custom reports within the OnCommand realm.
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1 Purpose

This document provides information to help OnCommand Unified Manager administrators and storage
administrators effectively use the reporting and custom reporting functionalities in OnCommand Unified
Manager 6.2 and 6.3. We provide workable examples along with this documentation.

2 Scope

This document intends to assist storage administrators, IT managers, and capacity managers in
preparing customized, comprehensive reports for the entire NetApp infrastructure in their organization.

3 Glossary of Terms

Acronym Description

OCUM OnCommand Unified Manager

UM Unified Manager

BIRT Business intelligence reporting tool from OpenText; the embedded reporting
engine in OCUM 6.2

Eclipse Open-source integrated development environment used to create report
definitions for BIRT

SVM Storage virtual machine

Vserver Virtual storage server, same as SVM

4 Introduction

An IT environment requires accurate and comprehensive reporting of its assets. These reports could be
informational, for measuring storage and capacity information, or just for administrative documentation.
As the number of reports increases, so does the complexity of the reporting process.

Starting with OnCommand Unified Manager 6.2, NetApp has introduced a reporting feature that provides
a comprehensive library of standard reports about the underlying NetApp storage infrastructure.
Administrators can easily obtain the information that they need. In addition, OnCommand Unified
Manager 6.2 extends the reporting capabilities to capture only desired data objects through its
customized, rich reporting feature.
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With OCUM 6.3, the reporting capabilities have been further enhanced:

¢ OnCommand Unified Manager 6.3 allows annotation tables to be exposed as a database view,
facilitating custom report creation by annotation dimensions.

¢ In OnCommand Unified Manager 6.3, custom reports without table elements in the report design
can be imported. Section 9, Portability of (Custom) Reports, provides more details.

4.1 OnCommand Report Features

An OnCommand report provides storage visibility and analytics for NetApp hosted storage systems in the
enterprise. Operating as agentless, browser-based software, OnCommand reports enable you to create
extensive reports on:

o Operations management: events, severity, and status trend charts
o Capacity: storage summary, aggregate, volume, qtree
¢ Inventory: cluster, SVM, volumes
You can leverage the reporting feature in OCUM 6.2 to:
e Customize core reports for additional use cases:

— Group, filter, sort, add compute fields, hide, and delete at the column level (for each
column) in the report.

— Get hints to customize the preceding list of additional use cases.
e Export and import report definitions to allow sharing.
e Schedule and share reports; view reports in PDF, CSV, XLS, HTML, or TXT format.

¢ Group storage resources with a single identifier for analysis and reporting; for example, by
business function or by application.

o Make full use of Eclipse, a third-party tool, to create custom, comprehensive reports that you can
import to UM as a design template.

5 Architecture Overview

Unified Manager has its own reporting content in conjunction with a wrapper to support the third-party
OpenText BIRT component. It also includes an Eclipse-based tool that connects to OCUM over port 3306
by using a MySQL Java Database Connectivity (JDBC) driver. Users can interact to view reports online
(in real time) and offline through sharing or exporting, or through scheduling of canned and imported
reports.

A database called ocum report has been added to the OCUM server, and it is accessible through an
OCUM database user who has a report schema role. This database provides wrapper views on
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OnCommand Unified Manager to support imported reports that are created by using Eclipse. BIRT uses
various customized, feature-rich RESTful APIs for background tasks: Share, Schedule, and Import
Reports created from BIRT.

6 Reporting Objects

6.1 Annotation

An annotation is a combination of a name-value pair that can be applied over storage objects in clustered
Data ONTAP—clusters, SVMs, and volumes—dynamically by using user-defined rules. This capability
helps create storage tags that can be used for reporting and administration of storage objects that are
linked to the tag. An annotation can bring together SVMs, volumes, and clusters in a single group for
better manageability.

An annotation name refers to the metadata that is associated with storage objects; examples of an
annotation include an application, a data center, and a business unit. A storage object can be associated
with one or more unique annotation names; for example, a volume can be associated with an application,
a data center, or a business unit.

An annotation value is the value associated with an annotation name. For example, Data Center =
New York, Application = Exchange, Business Unit = Finance. For a given object, an
annotation name can be associated with only one value.

With OCUM 6.2, you can create custom annotations by applying rules to augment supported storage
objects—clusters, SVMs, and volumes. The following conditions hold true for annotation association:

e A given storage object can have any number of annotation labels associated with it.

e A storage object can have only one annotation value for a given annotation name.

Rules and Values in Annotation

The rule editor contains a list of rules for applying annotations to storage objects. A rule is a statement
that involves:

o A storage object
e A condition
e An action
The storage object could be a FlexVol™, an SVM, or a cluster.
Each rule is in the following format:
if ($CLUSTER.NAME == 'clusterName') then { S$SCLUSTER.Location = <value name> }

In this format, Location is the annotation name and <value name> is the annotation value in this
example.
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Table 1) The following table defines the parameters or building blocks that could be used in creating rule
logic:

Building Block Description ‘ Builing Block Description
$VOLUME.NAME Used for the VOLUME.SVM.NAME Used for the SVM name
volume name. containing all the volumes.
$SVM.NAME Used for the SVM | $VOLUME.CLUSTER.NAME | Used for the cluster name
name. containing all the volumes.
$CLUSTER.NAME Used for the $SVM.CLUSTER.NAME Used for the cluster name
cluster name. containing all the SVMs.

Starting OCUM 6.3, the creation of rules is very intuitive. Once you have created an annotaton, add
values to the annotation, and then naviage to the “manage rule” tab to create definitions for associating
storage units to the annotation values.

6.2 Create Annotations

To create an annotation, use the following procedure:

In OCUM 6.2

1. Log in to Unified Manager as the OnCommand administrator.
2. Navigate to Administration - Manage Annotations.

NetApp OnCommand Unified Manager Help ~ | Administration ~ | admin | Sign Out
Dashboard Events Storage ~ Protection » Jobs Reports All Ed o Q.
ons
. Whan urces
Quick Takes @
Manage Events
Availability Capacity Performance Protectiol o isers

Heslthy 7 At Risk Il Have Incidents Hestthy [7] At Risk Bl Heve Incidents Hestthy [7] At Risk Il Heve Incidents. Configure Network Seftings |

Setup Options

40 - 399
3 o0 3 1

82 6 2
37 0 0 0 0 3
oo I Z H 52 0 BN LN '  ERES
Clusters SVMs Aggregates SVMs Aggregates Clusters SVMs Volumes Lag Status SnapVauit SnapMirror
(3 total) (399 total ) (42 total ) (399 total ) (42 total ) {3 total ) (399 total ) (3753 total ) {10 total ) (12 total ) {1440 total )

Unprotected Volumes: 1114

OnCommand Unified Manager Reporting for Clustered Data ONTAP



3. Create an annotation and add the annotation name and description.
MNOWADE ONComemmnd Unifod Managet

LT ) T wenis Bhimye - Pyartes e = R ) Hegunts

Manage Annotations &)

- Annotation Imp-SVMs
Dw scription

Cattm w WARAS fes anvven B0

s priaeity (V)
A (1)

Morm Avovirtatoen §0 b
CaCIangs (11
e BV (N Arnsteston Flarme  IWAH VM

[reramm— L Y el

Inte yomemasy (V)
B W Vetams (V)

Pdl @reranatan (1)
€D snsscrmes Comcs Vo  Cambers
Thevage vt Macbues
V-

Tare srsl Crome Cavew

4. After the annotation name has been created, you can add the possible values for it. First select the
created annotation and then select the New Value option. The required input is the value name.

Annotation: Imp-SVMs
Description

Critical 3VMs for acme BU

Values
(hree o
Vale New Annotation Value x|y
widginfclus-35
w_ﬂ_mu_umﬁud_&um@ Value: ||
wdgchansvmi
Cancel
5. To add rules to the value, click the Manage Rules button on the right-hand side.
| Manage Rules
Manage Rules € *
Annotation: Imp-SVMs | Eqit.| | Delete |
Enter rules in the box below. You can add comments for each rnule use £ at the start of each comment
Description Chck Vanables and Examples and see the Melp for more detads about creating rnules
Critical SVMs for acme BU gn Tules a
v #4 (SSVM NAME == ‘svmName’) then { SSVM data-prionty = mission-crtica )
alues Add rule here #Voiumes
#4 (SVOLUME CLUSTER NAME contans ‘clusterprefc’) then { SVOLUME data-priceity = high )
o thaw Voloe X Dl #Clusters
#4 (SCLUSTER NAME == ‘clusterName’) then { SCLUSTER data-priority = low}
Vale 100}
wognichs-35 =
vs_s&_source_supervised_Bumham_1405659058
wdgchansvm 1 v
Vaidate
o
Save Cancel Displaying 1-30f3
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Following is an example of a rule syntax:

if ($VOLUME.SVM.NAME == 'wdginfclus-35') then {$VOLUME.Imp-SVMs = wdginfclus-
35}

Where:

e wdginfclus-35 is the value.

e Imp-SVMs is the annotation name.

e S$SVOLUME.SVM.NAME is the rule parameter used.

When the rule has been created, it must be validated and then saved. Only validated rules can be
saved.

Note:

¢ Rules are maintained and managed as a global list. There is no annotation name- or value-specific
view of rules in OnCommand Unified Manager 6.2.

¢ Annotation names and values must be created before being used in a rule.
e The correctness of the rules can be verified by clicking the Validate button.

In OCUM 6.3

1. Log in to Unified Manager as the OnCommand administrator.

2. Navigate to Administration - Manage Annotations.

NetApp OnCommand Unified Manager Help - | Administration - | umadmin | Sign Out

~ Manage Alerts L
Dashboard Events Storage v Protection v Jobs Reports Al - Q
Manage Annotations
. Manage Data Sources
Quick Takes @
- Manage Events
Availability Capacity Performance Protect

| Manage Groups

Manage Scripts
Healthy | Af Risk B Have Incidents Healthy = At Risk B Have Incidents Healthy | AfRisk B Have Incidents iing M Error
Manage Users

Database Backup

3 ! 3 ! 3 Setup Options

[
wn
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3. Create an annotation and add the annotation name and description

Dashboard Events Storage - - - - —
Add Annotation i) x\

Manage Annotations &

Annotation Name’ | Datacenter

| Annotations H Annotation Rules |
Description: | Storage units by Datacenter regions

You can manage storage objects in your environi 1
create a new custom annotation. You can apply &

 Add Annotation | Ani

data-priority (3) Annotation Values
C deAdd X Delete

Valu Value

Save and Close Cancel
4. Add value to the annotation
NetApp OnCommand Unified Manager
Dashboard Events Storage ~ Protection ~ Jobs Reports All
. Description: Storage units by Datacenter regions
S i () Created By: admin
Creation Date: 30 Sep 2015
Datacenter (0)
Values
Add Apnotation Value x|
Stepl Fadd XD
Value Value: ‘ Boston| Hlic
No data found
Add Cancel
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5. Once added, click on manage rules tab to define the storage unit association to the value “Boston” in

the annotation:

Dashboard Events Storage v Protection ~ Jobs

Add Annotation | Annotation: Datacenter

Reports

Description:  Storage units by Datacenter regions

data-priority (3) Created By: admin

Creation Date: 30 Sep 2015
Datacenter (1)

Values

Add X Delete
Value

Boston

Associated Rules
Rank « Name

No data found

T | Target Object Type

6. Furnish the details on the rules creation page

NetApp OnCommand Unified Manager Add Annotation Rule i)

Dashboard Events Storage ~ Pr

Manage Annotations &

[ﬁAnnotations H Annotation RuI057|

Annotation rules automatically apply annotations to storage ¢
objects. New rules created are added to the end of the list. T

g Add # Edit X Delete 0 R

a Name

found

Name:

Apply Annotation:

@ Conditions

Object Name
[#] Add Condition
Or

Object Name

(#] Add Condition

+ | Add Condition Group
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Applicable Clusters
o

All ¥ | Search ‘ Q

Applicable SVMs.
0

T Associated Annotation Value

Boston-rule

@ Target Object Type: | Volume

Datacenter

v | Contains

v | Contains

! Actions ~

Applicable Volumes [E
0

Displaying 1 -1 of 1

‘ Manage Rules
T  Applicable Objects | [

v
v | Boston - v
v I 0
N L)
| Cancel

Lt

at



Step1: Click on “Add”

Step2: Give a name for your rule

Step3: Select the target object type you desire. You can select — SVM, Volume or Cluster
Step4: Apply this rule to the annotation you desire

Step5: Associate this rule to the value you desire

Step6: Add conditions to your rule, selections can be Cluster, SVM or volume name
Step7: Apply the condition logic — either “contains” or “is” for specific match

Step8: Enter the exact name or part of the name string you want to match in your search

Once complete, click on “Save and Add” and close the window.

7 Reporting Dashboard

The reporting dashboard is the main page where all the reports are categorized and listed. The various
reports available fall into one of the following categories:

e Capacity utilization
e Operational

¢ Inventory

e Imported

To navigate to a reporting dashboard, click the Reports tab.

NetApp OnCommand Unified Manager Help ~ | Administration - | admin | Sign Out

Dashboard Events Storage ~ Protection ~ Jobs All v || Search Q.|
8 11:15, 24 Mar: Cluster F2240-127-26_28 is not reachable and is no longer monitored. | Details | 9
Reports & | Impert Report | | Manage Repor Schedules | Expand All

Capacity Utilization
Operational Reports
Inventory Reports

Imported Reports

In the dashboard, the first three categories contain built-in reports. To view the reports in a category,
expand that category. You can further customize these reports by excluding certain fields; this step is
explained in section 6.1.

In last reporting category, Imported Reports, you can use Eclipse, an open-source reporting designer
(free license), or the OpenText Actuate Analytics Designer (free commercial-grade designer) to customize
reporting to meet your comprehensive needs. To customize Imported Reports, the BIRT reporting engine
must be installed on the system.

For further details on BIRT, go to the following the links. These links also provide information about
installation procedures for the respective packages:

e Eclipse IDE for Java and Report Developers:
http://www.eclipse.org/downloads/packages/eclipse-ide-java-and-report-developers/marsr
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e “All-in-one” package for download:
http://download.eclipse.org/birt/downloads/

¢ Analytics Designer:
http://birt.actuate.com/products/analytics-designers/analytics-designer

7.1 Reporting Functions

The reporting function in OnCommand helps you get a comprehensive view of the NetApp devices in the
environment: capacity management, operations management, and so on. In particular, you can perform
the following categories of OnCommand reporting functions:

o View reports under the reporting categories listed in the dashboard, as mentioned previously.
e Run areport.

e Schedule a report.

e Further customize canned reports.

e Import a report from the third-party Eclipse designer tool.

View Reports

You can expand each of the reporting categories to view the various reporting capabilities within the
category. For example, when you expand the Capacity Utilization category, the following built-in reports
are available:

NetApp OnCommand Unified Manager Help ~ | Administration ~ | admin | Sign Out
Dashboard Events Storage - Protection - Jobs Reports All v | Search Q
° 11:15, 24 Mar: Cluster F2240-127-26_28 is not reachable and is no longer monitered. | Details | 9

Reports © | import Report | | Manage Report Schedules | Collapse Al

[=] capacity utilization

Storage Summary

Run Report
Analyze storage capacity and utilization of your storage system to quickly understand key areas such as capacity risks, and availability trends.
Aggregate Capacity and Utilization Run Report
Analyze aggregates capacity and utilization in a cluster to understand possible capacity risks and to view the configured, used, and unused capacity of aggregates.
Volume Capacity and Utilization | Run Report |
Analyze volume capacity and utilization in a cluster fo understand possible capacity risks and to make decisions about enabling space-saving features such as deduplication, thin provisioning, and so
on.
Qtree Capacity and Utilization | Run Report |

Analyze capacity and utilization of the system's girees to understand possible risks that might occur due to reduced cluster capacity.
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http://download.eclipse.org/birt/downloads/
http://birt.actuate.com/products/analytics-designers/analytics-designer

Run a Report

NetApp OnCommand Unified Manager Help ~ | Administration ~ | admin | Sign Out
Dashboard Events Storage - Protection - Jobs Reports Al v | Search lQ
8 11:15, 24 Mar: Cluster F2240-127-26_28 is not reachable and is no longer monitored. ‘ Details ‘ 6

Reports Import Report | | Manage Report Schedules | Collapse Al

[=] capacity utilization

Storage Summary | Run Report
Analyze storage capacity and utilization of your storage system to quickly understand key areas such as capacity risks, and availability trends

Aggregate Capacity and Utilization Run Report

Analyze aggregates capacity and utilization in a cluster to understand possible capacity risks and to view the configured, used, and unused capacity of aggregates.

To run a report, expand a category and click the Run Report button next to the report that you want. You
are then taken to the report details page.
Schedule a Report

With the scheduling feature, you can schedule a specific report and send the report to administrators and
other requisite recipients by e-mail. Various reporting formats are supported, including PDF, HTML, CSV,
Excel, and so on.

To schedule a report, go to the individual report summary page. Click Manage Report Schedules and
then complete the following fields:

e Schedule Name

¢ Recipient E-mail Address

e Report Format

e Frequency (of the reporting intervals)
¢ Report Category

The drag-and-drop feature allows you to add specific fields within the schedule.

Report: Storage Summ~=-“*

Manage Report Schedules | (| | Actions ~ | | Refresh
Scheduled: No Manage Report Schedules € ~
— Schedules {0) I
Add Schedule Schedule Name:
No schedule exists cipient Email Address: N

Storage Capacity Utilizatio Enter email addresses separated by commas.

“ @) ) ~ ) )
Report Format: (®PDF (UXHTML (JCSV  (UBxcel (O Text

Frequency: () Hourly (JDaily (8 Weekly ()Monthly

‘Aggregate Total Capacity (TB)
8

at HH:MM on Select Day i
Report Category:  Capacity v
w ® Available Reports: Selected Reports
B Storage Summary
A
o Aggregate Gapacity and Utilization
y Volume Capacity and Utilization
o Qiree Capacity and Utilization
Storage summary with protection capacity
Aggregare Capacity Utiilization Customized
Cluster . Capacity (TB) Unconfigured Raw Capacity (TB)
+
=] wdginfiirclus01

14.889 1221
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Enhance Canned (Built-in) Reports

You can further customize the canned, built-in reports by selecting only the reporting fields that you want

to view in your report. To customize a report, you must first enable interactivity on the report by selecting
Enable Interactivity.

MNetApp OnCommand Unified Manager

Dashboard Events Storage ~ Protection - Jobs Reporis

8 11:15, 24 Mar: Cluster F2240-127-25_28 is not reachable and is no longer monitored. | Details |

Report: Storage Summary &
Scheduled: No

Enable Interactivity

iew

L Unused Used
= Export Content
£ ExportData
"

<

& Print

k-

=

a

T Help

g

= T

When interactivity has been enabled, you can customize your report to sort, filter, or delete a row or a
column from the report. When the report has completed, you can either save the modified report for future
reference or schedule the same report run.
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To customize a built-in report, click any of the columns in the report and explore the various features that
are available at your disposal

Dashboard Events Storage - Protection ~ Jobs Reports
° 11:15, 24 Mar: Cluster F2240-127-26_28 is not reachable and is no longer monitored. | Details |
Report: Storage Summary &
Scheduled: No
- Header 4
Cluster HA Pair T 4~ Group b i Version
£ wdginffirclus01 IL Column >
wdginfiirclus01-01Awdginfirclus01-02 12
¥ Aggregation
[ clus_cpe-f3270-104-36-35-40-42 T Filter L4
f3270-104-40/F3270-104-42 llsteam__8.3.0
f3270-104-36/f3270-104-33 t Sort Y listeam_83.0
Alignment 4
£ F2240-127-26 28 Aa Format -
F2240-127-26/F2240-127-28 FASLI80-4 8.3RC1

8 Custom Reports

You can import customized reports built from the Eclipse tool into the OnCommand Unified Manager
server by using the import feature in OCUM. Report designs that you create by using Eclipse are saved
as XML files with an . rptdesign extension.

To import a report:

1. On the report landing page, click Import Report at the top of the page. An import report window
then opens.

NetApp OnCommand Unified Manager Help ~ | Administration ~ | admin | Sign Qut

Dashboard Events Storage ~ Protection ~ Jobs Reports Al v | Search la

Reports & $\ Import Report | | Manage Report Schedules | Collapse Al

[=] capacity utilization

o4
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2. In the Import Report window:
a. Browse to the . rptdesign file that you intend to import and click Open.
b. Provide a name for the report.
c. Add a description for the report.
d. Click Import.

Import Report & *®

&) Select Report File: Browse...

&) Name:

&) Description:
Maximum of 150

characters

Cancel

The imported report is now available on the report landing page, under the Imported Reports category.

Note: Inan OCUM 6.2 instance, if a report (. rptdesign file) does not have table elements in the
report design, it cannot be imported. NetApp has rectified this limitation in OnCommand Unified
Manager 6.3. For further information, follow BURT 879029.

8.1 Create Reports with Eclipse

To produce feature-rich custom reports, you can leverage the open-source Eclipse tool or the OpenText
Actuate Analytics Designer.

To install the Eclipse tool, use either of the following links:

e Eclipse IDE for Java and Report Developers:
http://www.eclipse.org/downloads/packages/eclipse-ide-java-and-report-developers/marsr

e “All-in-one” package:
http://download.eclipse.org/birt/downloads/

To download the OpenText Actuate Analytics Designer, go to:

e http://birt.actuate.com/products/analytics-designers/analytics-designer

You can install Eclipse on the Windows, Mac OS X, or Linux operating system. To set up and configure
the designer of your choice, follow the installation instructions that are available with the software.
Prerequisites

Eclipse needs a connection to the OnCommand Unified Manager database. Eclipse uses port 3306 to
connect to the OCUM server through a JDBC connector and a database user for authorization.

To create a database user in the OCUM server, you must:
1. Log in to OCUM as the OnCommand administrator.

2. Navigate to Administration > Manage Users.
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3. Click Add, and add a database user with Report Schema as the Role definition.

Add User & X

Database users with the Report Schema role, have read-only
permissions to access repon-specific database views directly from
the database.

qr

Type: Database User
Name: dbuser

Password. seeees

Confirm Password:  «eee..

1

Role:  Report Schema

| Add | Cancel

Create a Custom Report Project

In this section, we assume that you have set up Eclipse on another system by following the instructions in
the steps and procedures in section 8.1.

These instructions are based on the Windows version of Eclipse. The Linux and Mac OS X versions
behave similarly.

To create a custom report:
1. Log in to the system that is hosting Eclipse and open the application.
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2. After opening Eclipse, change the view to the Report Design perspective. Click Window = Open
Perspective - Report Design.

File Edit Mawigate Search Project Run  Design | Window Help
ot L om Q- Mevy Windaw = ~

. a3

Editar r

Hide Toolbar

[8 DataExplorer 53 rojeck &3 = disk_irventaon

& data view is not available. Cpen Perspective M| Report Design
Shiow Yigw 3

Customize Perspective. ..

Save Perspective As... projectDescription
Reset Perspective... [e] name
Close Perspective (] comment
Close all Perspectives (2] projects

[2] buildspec
Mavigation 2 [€] natures
Preferences

3. To create a new project, navigate to File > New - Project. The following screen appears.

= New Report Project !E‘
Report Project o
Project name must be specified |; E.I
—l.l.

Project name:! ||

¥ Use default locatian

Location; IC:'I,Users'l,.ﬂ.dministrator'l,workspace.pgh Brawse, ., |
Chonse File system: Idefault 'I

L7 < Back TExt = | Finish I Cancel
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4. In the wizard, click New Report Project and click Next.

= Report Design - C:4Users' Administratorworkspacetest_project' .project

File Edit Mavigate Search Project Run Design  Window  Help
Ale+Shift+M  » | g Project. ..
Open File. ..
[ Falder
Close ChrlH 7
Repark
Close &l CtrlShift-+ P
@] Template
Sane CErH-S fiif Library

lz| Save As...
= Example. ..

Save &l [ o e ] e

Rewert = Cther... CErl+1
[Mave. ..

Rename... 2

Dafrach EC

5. On the Eclipse launching page, create a new project. Navigate to New Project - Report Project
and then click Next. Provide a name for the project and click Finish.

806 New Project

Select a wizard

Create a new Report Project.

Wizards:
type filter text
[ P (= Ceneral
¥ [=-Business Intelligence and Reporting Tools
|& ODA Designer Plug-in Project
.u_, ODA Runtime Driver Plug-in Project
P (= CVS
> (= Eclipse Modeling Framework
> (=EB
P (= Java
» (= Java EE
P (= JavaScript
b (= JAXB
> = JPA
» (= Plug-in Development

C| < Back m |  Cancel | Finish
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8.2 Create a Custom Report

1. To create a new report under a project, click File > New - Report.

8006 New
Select a wizard

This wizard creates a new Report from a predefined template.

Wizards:
type filter text

» (= General
¥ (= Business Intelligence and Reporting Tools
il Library
[ ODA Designer Plug-in Project
ODA Runtime Driver Plug-in Project
Report
1o’ Report Project
IE_E Template
» = Connection Profiles
»=CVs
» = Database Web Services
P = Eclipse Modeling Framework
» (= EB
P (= Java

@ < Back | cancel Finish

Alternatively, you can right-click the new project and select New. In the selections, click Report.

Report Design - pgbl/.project - Eclipse

File Edit Mavigate d T Project...

. Open
.- ~ Open with b L Folder

%:: Report

8 DataExplorer H_ Copy
# data view is not a Paste

€ Delete

Move,., 1 Example...
Rename...

@] Template
i Library

=1 Other... Chrl+h

(= Impork... [8] comment

[i»g Export... [e] projects
(] buildspec
[8] natures

- | Refresh

Yalidate

Shaow in Remote Systems view
Profile fs

Debug As

Run &s

Team

Replace With

IPA Tools

Compare With

Saurce

* rF ¥ v v v wvw

Properties

T Mavigator 33

& Remowve from Context (ZErH-AIEA-ShifA-Dovn
=-® Demo Proje

fMark as Landmark o 2 e
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2. Provide a name for the new report. You can use the default location, or to type in a new location
where you want to store all reports, uncheck the Use Default Location box. Click Next.

=Mew Report Project

=l
Report Project =
Create a new report project, ==
it
Project name: | Do Project\
¥ Use default lacation
Location: | CiiUsersiAdministratoriworkspace, pab\Dema Project Brovise. .. |
Choose file system: |default 'l

@

< Back | Hext = | Finish I

Cancel |

3. Create a new data source. Click the project and then right-click Data Source. Select New Data
Source.

-

f9 Diata Explorer 52

({3 Reporte.
@ Wariables

o Mavigator 53 Cutline

BEG|e 7=
E|[fj Ciemo Project

- X .praject

Step 1

[ new_teport, rpkdesg.
=% pgbt

i

Renort:
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4. Select the Create from a Data Source Type in the Following List and then select JDBC Data
Source from the drop-down menu. Type a name in the Data Source Name field. Click Next.

&= New Data Source |_ (O] x|
Select a Data Source Type or Choose a Connection Profile. [ -y
Provide all the settings For a new data source, or choose a pre-defined connection prafile. 1

IG" Create from a data source bype in the Following list I
Create From a connection prafile in the prafile store

Cassandra Scripted Data Source

lassic Models Inc, Sample Database

Excel Data Source

Flat File Data Source
Hive Data Source

PO Data Source
Scripted Data Source
‘Wb Services Data Source

#ML Data Source
Key in a data source name
Data Source Name: I MNew Data Suurce| Y
)

\2) < Back I Mext = I Finish | Caneel |

Note: If you have already created a connection profile, you can instead select Create from a

Connection Profile in the Profile Store. For details about the benefits and use of a connection
profile see section 9.1, Connection Profile.
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5. Provide the database URL (replace the IP here with the FQDN/IP of Unified Manager), user
name, and password from the Prerequisites section. In addition, provide the following information
in the applicable fields:

a. Add the database driver by clicking the Manage Drivers button. Select the mysql -
connector-java-*-bin. jar file that is available to you.

b. Driver Class: com.mysqgl.jdbc.Driver (v5.1).This name is available as a drop-
down selection.

c. Database URL: jdbc:mysqgl://<ip address of OCUM
server>:3306/ocum_report

d. User Name: The name of the database user that was created in the OCUM server for the
BIRT designer.

e. Password: The password of the database user.

=Mew JDBC Data Source Profile |_ (O] =]
Create a new data source —

Create a new data source,

Driver Class: j -
Database URL: | jdbcimysgl: 10,238,221, 200, 3306/ ocum_report

User Mame: I birkuser

Password: | LTITIYYY)

JHDI URL: |

Manage Drivers... | Tesk Connection... | Bidi Settings. ..

E

li?)' < Back Mexk = | Finish I Cancel

Note:

¢ You need not fill in the “JNDI URL” field. This is not required

e You should test the connection by clicking Test Connection to validate a successful connection to
the OnCommand Unified Manager database. Then click Finish.

e You can use the FQDN instead of the IP address for the Database URL.
e For an IPv6 address, the Database URL field should be in the following format:

jdbc:mysql://address=(protocol=tcp) (host=£fd20:8ble:b255:8477:42f:11e:64
e3:5338) (port=3306) /ocum_report

Where host=£fd20:8ble:b255:8477:42f:11e:64e3:5338 is the host IPv6 address.
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6. Create a dataset. Navigate to Data Explorer > Data Set and click New Data Set.

= Repott Design - Demo Project/new_report.rptdesign - Eclipse

File Edit Insert Element Data Page Mavigate Search Project  Run

H-EHe e dD @ QB Y
[8 DataExplarer 51 = g
EIE@ Data Sources

------ B Dremo Crata Source

Mew Daka Set
Mew Joint Data Set

i [T} Paste

7. Select the data source that you created in step 4 and:

a. Select SQL Select Query from the Data Set Type drop-down menu.

b. Type in a name under Data Set Name.
c. Click Next.

=New Data Set

=] E3
New Data Set

Define the data set's name, source, and bype E' 1

r~Data Source Selection

bype filer text

R

Demo Data Source

Data Set Type:

ISQL Seleck Query j
Data Set Mame:
| Data Set

@

< Back I Mext = I Fimisti

Canicel
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8. When the SQL query window appears, define a SQL query for the report that you want to
produce. To create a query, use the fields from the Available Items on the left-hand side. Expand
an item to use the fields that are available under that item.

8.0.06 Edit Data Set - disk-query
Data Source Define a sql query text using available items.
Query
Output Columns :
Cor:pu!ed Columns Available kems: Query Text
Parameters v a jdbe 1select disk.nome, cluster.name, clusternode.name,
Filters » [Baggregate 2 disk.model, disk.containerType, disk.interfaceType
Property Binding » @ annotation 3 frcm d\}lf : i
Settings 4 inner join cluster on disk.clusterld « cluster.id
» Mcifsshare < p : .
Preview Results S inner join clusternode on disk.ownerNodeld = clusternode.id
» M cifsshareac!
» B cluster
» @ clusternode
» [@hdisk

» [ diskaggregatemapping
» [ exportpolicy
» [ exportrule

When you have completed your selections, click Finish to view the results.

Note: If an incorrect query syntax or logic statement has been submitted, an error occurs and
the user is alerted with a popup message.

9. Select the output columns that must be part of the report and click OK.

8 00 Edit Data Set - Data Set

Data Source Qutput Columns T
Query

Output Columns
Computed Columns

Define output columns:

Parameters Name Type Alias Display Name Display Name Keg' |T|
Filters name String name —
Property Binding type String type

Settings resourceld Decimal resourceld

Preview Results resourceType String resourceType
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10. Drag the columns from the Data Sets to the Detail Row in the table in the order that you want to
present them.

11. After you have saved the query, you can review the output by using a browser. Select the report
available in the bottom left-hand corner and click Run - View Report > As HTML.

=Report Design - pgb1 /basic_DP_status.rptdesign - Eclipse
File Edit Insert Element Data Page Mavigate Search Project | Run  Window Help

= . ) E'Q'E%'Eb § - = ﬂDabugReport | =1L

. -

& view Report [d & In web viewer

{8 DataExplorer 23 9 ’]_‘a Generate Document u'p] A5 Do
._@ Data Sources @ Exteral Tooks R il As DOCK
- = P
E-ER wvoluneR.elationship o ) 4s ODR
..... g ges:?na:?on Eludster ._D 2 s o5
---- estination Mode 4
----- El Destination valume R i G.J el
----- El Destination SvM - [rieatth {1 ASIFDR
----- El Health Status B il s POSTSCRIPT
""" B Health : (Heat [ A5 PPT
""" 8 Lao - ) fs PPTA
----- El state - 2 4 5
""" Bl status =
..... B Source Cluster . ga &5 ¥LS_SPUDSOFT
""" Bl source Node ~ O As HLSK
""" Bl source valume
""" Bl source swm
---- [ Data Cubes -
---- [£3 Report Parameters )
----- (& Variables -
m
T Mavigator 3 EE Cutling — <§|) A ] N

E1-2® Demo Project

- |X| .project

nevs_report, rpkdesign
Elu pabl

12. To import this report into OnCommand Unified Manager, locate the new report.rptdesign
file, which is normally available under the workspace location that you defined during installation
of Eclipse. Copy this file to a system that can browse Unified Manager and use the importing
function as explained in section 8, Importing Reports.

9 Portability of (Custom) Reports

Custom OCUM reports created through the BIRT designer can be imported from one environment to
another. That is, you can now import a report (. rptdesign) file that you created in OCUM instance A to
OCUM instance B seamlessly, but with a few configuration changes, which are detailed in the following
sections.

9.1 Connection Profile

A connection profile contains the connection property information that is required to connect to a data
source (in this case, an OnCommand Unified Manager database). By using a connection profile,
administrators don’t have to repeat the connection definitions or add the required MySQL drivers multiple
times for each “custom” report to be created under a single Unified Manager instance. In addition, an
administrator can also use connection profiles to port external BIRT reports (. rptdesign files) from
another environment.
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A connection profile is an XML file with an .acconnprofiles extension that contains the database
connection-related data that the BIRT run-time environment understands. Optionally, you can encrypt the
entire content in the connection profile. The following are the major components in a connection profile:

e Data source name
e Database server class information
e Database URL that connects to the OCUM database

e Database user name and password to connect to the OCUM database

Advantages of Using a Connection Profile
With a connection profile, you can:

e Create the profile just once for multiple or all the reports that are used in a Unified Manager
instance and its associated storage objects.

e Create multiple reports without having to reenter the connection parameters (database driver,
user name, and password), thereby saving a lot of time.

e With a simple understanding of the connection profile, import the same report to multiple OCUM
instances (the same file name but different parameters).

e Encrypt content (optional).

Prerequisites

The following components are required to create a connection profile. You can download these
components in the host where you are installing the BIRT instance:

o BIRT designer editor (Eclipse with a BIRT plug-in or Eclipse from Actuate).
o Fully operational OCUM server with a report user created.

e Downloaded mysgl-connector-java-*-bin.jar from the web. For optimal reporting
solutions, NetApp recommends the version mysgl-connector-java-5.1.26-bin.jar. You
can download this version from http://downloads.mysqgl.com/archives/c-j/.

Note: The OCUM server must be in the same network as that of the server that hosts the BIRT
designer, or, at a minimum, it should have port 3306 allowed.
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9.2 Create a Connection Profile

Before you can create a connection profile, you must create a report user on the OnCommand Unified
Manager server. Log in to the OCUM server in your environment and navigate to Administration >
Manage Users. Create a report user with the user type Database User and with the role Report Schema.

Add User X

o Database users with the Report Schema role, have read-only
permissions to access report-specific database views directly from

the database.

Type: Database User A
Mame:  gcum report user
Password: sessssss

Confirm Password: | ssssssss

Rale: %Repurt Schema -

Add Cancel

Now log in to the host where you are installing the BIRT station. The following steps guide you in the
creation of a connection profile:

1. From the main menu, select File > New = Other.

2. Under Connection Profiles, select Connection Profile from the wizard and click Next.

= New M=
Select a wizard <
Create a connection profile
‘Wizards:
bype filker text
-
[
=
'\3) < Back I Mexk = I Finisk Caneel
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&

Select the connection profile type.

Enter a unique name for the connection profile type.

Select BIRT JDBC Data Source under Connection Profile Types. Enter a name and a description
identifier for the datastore. Click Next.

= New Connection Profile =]

Connection Profile
Create an BIRT JDEC connection profile

r— Connection Profile Types:

type Filker text
| ———

|»

el o -
LEBIRT JDBC Data Source

@BIRT Sample DB Data Source

4 DB2 For Linue, UNEE, and Windows

4 DBz for i5/05

4 082 For zj0s

4 Derby

@ Excel Data Source —
E=Flat File Data Source

{4 generic J0BC

EdHsqLDE

4 tnfarmix

Ed Ingres

4 IDBC Database Connection for Query Builder ﬂ

Mame:

I Dema-Project data store

Description {optional):

I Demo Project data storel

(?) < Back I Mext = I Finish Cancel

Note: Make sure that you write down the data source name. This information is extremely
important from a report portability perspective. If you need to import another report (an
.rptdesign file from an external BIRT server or from another environment), your BIRT
server must have the same data source name while creating the connection profile.

Complete the required information in the wizard for your connection profile type. Provide the

database URL (replace the IP here with the FQDN/IP of Unified Manager), the user name, and

the password from the Prerequisites section. In addition, complete the following fields with your
information:
a. Add the database driver by clicking the Manage Drivers button. Select the mysql-
connector-java-*-bin.jar file that is available to you.
b. Driver Class: com.mysqgl.jdbc.Driver (v5.1). This name is available as a drop-
down selection.
c. Database URL: jdbc:mysqgl://<ip address of OCUM
server>:3306/ocum_report.

d. User Name: The name of the database user that was created in the OCUM server for the
BIRT designer.

e. Password: The password of the database user

Note: For an IPv6 address, the Database URL field should be in the following format:
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jdbc:mysql://address=(protocol=tcp) (host=fd20:8ble:b255:8477:42f:11le:64
e3:5338) (port=3306) /ocum_report

Where host=£d20:8ble:b255:8477:42f:11e:64e3:5338 is the host IPv6 address.

7. Test for a successful connection to the OCUM database through the Test Connection button in
the New JDBC Data Source Profile window.

(=MNew JDBC Data Source Profile H[=1E

Create a new data source

Create a new data source, |

Driver Class: j -
Database URL: | jdbecimysali /10,238, 221, 200: 3306 /ocum _repart
User Mame: I birkuser
Password: | LTITIYYY)
INDT LRL: |
Manage Drivers,.. | Test Connection... | Eidi Settings...

® < Back Mext = | Finish I Cancel

9.3 Create Reports by Using a Connection Profile
To create a report by using a connection profile:

1. Create a new report in your report project by clicking File > New - Report.

800 New
Select a wizard

This wizard creates a new Report from a predefined template.

Wizards:
type filter text
¥ (= Ceneral

¥ [=-Business Intelligence and Reporting Tools

fiif Library
[ ODA Designer Plug=in Project
<5 ODA Runtime Driver Plug-in Project

kH Report
1o Report Project
[l Template
» = Connection Profiles
=i

» (= Database Web Services

P (> Eclipse Modeling Framework
> (=68

P (= Java

C’J) < Back Cancel Finish
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Alternatively, you can right-click the new project and select New. In the selections, click Report.

&= Report Design - pgb1

File - Edit - Navigate [T — roi-...

: Qpen
D=L -
i L] - Open With y [ Folder

[f Data Explorer (2] Copy

& data view is not &, Paste

25 Delete
Mowve, .. = Example...

@] Template
i Library

Rename,..

= Other. .. Chrl+h

i 000
[ Irnpark [8] comment

[ Export... [e] projects
[2] buildspec
[8] natures

Refresh

Yalidate

Showe in Femote Systems view
Profile As

Debug As

Run As

Team

Replace 'With

JP4 Tools

Compare iikh

Source

v T v v v vy v w

Properties

o Mavigator I3
Remaye from Contexk L 4| B W T

Mark as Landmark Zhrl+HAlE+ShittHU

EI[LE Demo Proje
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2. Provide a name for the new report. You can use the default location to store all reports by
checking the Use Default Location box. Click Next.

Report

Create a new report.

Enter or select the parent folder:
Use Default Location
| fdfm-report-app/Report Designs

it

4 15 dfm-report-app
[= bin
[= idelib
(= Report Designs

[+ =% SIC
I 151 Examples for NetApp

[+ IE‘J- Test2

File name:  Test_Reportl_Using_Connection_Profile.rptdesign
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3. Select the type of report from the report template; in this case, we have selected a blank report.
Click Finish.

Report

Choose the type of report you want to create.

Report templates: Preview:

4 i Standard
[ Blank Report
B MyFirst Report
B simple Listing
[ GroupedListing
B Dual Column Listing
B Dual Column Chart & Listing
B Side by Side Chart & Listing
B Chart & Listing
B CrossTab
B UM_report_chart listing
B UM_report_listing
4 i Actuste
[ Blank Auto Interactive Report

Date

Description:

Create a blank report with no
predefined content.

Show Report Creation Cheat Sheet
[¥] Include the default themes

@ Nea>

4. Forthe new report, create a data source by using the connection profile option. Click Next.

Select a Data Source Type or Choose a Connection Profile.

Provide all the settings for a new data source, or choose a pre-defined connection profile,

(0) Create from a data source type in the following list

Create from a connection profile in the profile store

Actuate Data Object Data Source
Actuate Information Object Data Source
Actuate JDBC Salesforce.com Data Source
ActuateOne for e.Reports Data Source
Amazon DynamoDB Data Source
Amazon RDS Data Source

BIRT Report Document Data Source
Cassandra Scripted Data Source

Classic Models Inc, Sample Database
Cloudera Hive Data Source

Excel Data Source

Flat File Data Source

HBase Hive Data Source

Hive Data Source

JDBC Database Connection for Query Builder
JDBC Data Source

MongeDB Data Source

PQJQ Data Source

Scripted Data Source

Static Data Source

Web Services Data Source

AML Data Source

Data Source Mame:! | Data Source

<Back | Nea> || Fnish || Caneel
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5. On the Connection Profile screen, click New.

) Connection Profile o s ef S

Select a Connection Profile

Select the connection profile from which to create a data source

Connection Profile Store: Browse... |

Use externalized properties in Connection Profile Store

Use the default data source name

Data Source Mame:

6. Select your connection profile. Provide a file name and a path in the Specify a File Name field to
create a profile at that location.

Note: This step is one-time operation; after you have taken this step, you can always choose
this file in step 5 by clicking Browse.

File extension(s) to display: .acconnprofiles

Select a Cq a [= dfm-report-app
Select the & [ settings

> [= Report Designs
| (& bin
dj [ (= idelib
= J
=]
Specify a file name:  um_dsl_connection|
rptdesig)|
Use the default data source name
Data Source Marme:
files
= —
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7. In Create a Connection Profile Store, click OK.

La
A =N &I
) Connection Profile e - = . ——

Select a Connection Profile

Select the connection prefile from which to create a data source

Select the connection profiles to be included in the store:

8 BIRT Classic Models Sample Database
S ocum_conn

[ Selectall | [ Deselectal

Specify a file name:  Report Designs/um_dsl_connection.acconnprofiles

Encrypt file content

M @

Use the default data source name

Data Source Mame:

<Back | Net> |[ Fmish  |[ concel

Select a Connection Profile

Select the connection profile from which to create a data source

Connection Profile Store:  Report Designs/um_ds1_connection.acconnprofiles

Use externalized properties in Connection Profile Store

Browse... |~

4 ODA Data Sources
4 IDBC Data Source
um_dsl

Use the default data source name

Data Source Mare: um_dsl

<Back | Nea> ][ Finish

| [ cancel
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9. After the process has finished, you can see the connection profile with the .acconnprofiles in
your workplace, and a datastore is created for you.

g

<% Palette [§ Data Explorer 23 fifj Resource Explorer = B8

[ Y

i Data Sources

| um_ds1|

Data Sets

Data Models and Data Cubes
Report Parameters

Variables

e

EE Outline T3 Navigater i3 =]

a |51 dim-report-app
(= bin
I [= idelib
4 [~ Report Designs
m Test_Reportl_Using_Connection_Profilerptdesign

|Z] um_dsl_connection.acconnprofiles

| »

10. Now you can create a dataset with the desired query to create a report. Click Next to query for
the dataset.

4 s k=

Eofir b el

 IDEC ks Ty
-

s e P
T, e G
s g

L vp—
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11

Query

Define a sql query text using available items,

Available ltems: Query Text:

. Fill in the query and click Finish.

| New Data Set (=

» (B aggregate .| 1select aggregate.name, aggregate.state, aggregate.sizeTotal, aggregate.sizeUsed -
» [ annotation

» [ annotationofclusterview

» [ annotationofvelumeview

» [ annotationofvserverview

» EH cifsshare

» [ cifsshareacl

> E cluster

» 81 clusternode

» [ disk

» B diskaggregatemapping

» (@ exportpolicy

» [ exportrule

» [ fepport

> B I

> [ lun

» (B2 networkport

» [ gtree

» [ gtreequota

» [ storagepool

» [E storagepoolaggregatemapping
» [ svm L4
» E svmaggregatemapping

» 0 userquota

» [ volume

» [ volumeoutgoingrelationshipview =

2 from aggregate;

Filter:
Type:
[]Show system tables
Show alias

When adding selected items to SQL
[] Quote all identifiers

[7Include schema in item name

[-An- -

Note:

You should create the data source by using a connection profile.
Do not provide a name for the data source.
You should select the Use the Default Data Source Name checkbox.

Create an encrypted connection profile. (This step is optional and is offered in case you want a
secure method of communication.)

The . rptdesign file with a connection profile has the following lines under the Data Sources
design element. You can review the lines in bold to identify that the report is using a connection
profile.
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<property name="odaDriverClass">com.mysqgl.jdbc.Driver</property>

<property name="odaURL">jdbc:mysql://192.168.1.1:3306/ocum report</property>

<property name="odaUser">birtuser</property>

<encrypted-property name="odaPassword" encryptionID="base64">bmV0YXBWMSE=</encrypted-property>
<property name="OdaConnProfileName">NtapReport</property>

<property name="OdaConnProfileStorePath">Conn/ntap_conn.acconprofiles</property>

Note: For an IPv6 address, the database URL should be in the following format:

jdbc:mysql://address=(protocol=tcp) (host=£fd20:8ble:b255:8477:42f:11le:64
e3:5338) (port=3306) /ocum_report

Where host=£d20:8ble:b255:8477:42f:11e:64e3:5338 is the host IPv6 address.

Import Reports by Using a Connection Profile
To import external reports (. rptdesign files) into your environment:

e You must have a connection profile that was created in your OnCommand Unified Manager
instance before you can start importing a report by using the connection profile.

e You should use one connection profile per OCUM instance. The same connection profile cannot
be used for multiple OCUM instances.

¢ Reports that are imported with or without connection profiles stop working if:
— The report user is deleted.
— The report user password is changed in the OCUM server.

— The OCUM server URL has changed (it must be the same URL that you used when you
created a data source profile; for example,
jdbc:mysgl://192.168.1.1:3306/0ocum_report).

e You should keep a copy of the original . rptdesign file that you want to import.

Note:
e You can replace the IP address with the OCUM server FQDN in the Database URL field.
e For an IPv6 address, the Database URL field should be in the following format:

jdbc:mysql://address=(protocol=tcp) (host=fd20:8ble:b255:8477:42f:11e:64
e3:5338) (port=3306) /ocum_report

Where host=fd20:8ble:b255:8477:42f:11e:64e3:5338 is the host IPv6 address.

Configuration Changes
To import an external . rptdesign file, you need to make a few configuration adjustments:

1. Log in to the OCUM instance and create a directory called Conn under the reports directory. For
Linux systems, the default location is /opt/netapp/ocum/reports/.

Note: For OnCommand Unified Manager servers that are deployed as vApp, you log in to the
server by using root credentials.

2. Copy the connection profile that you created for this OCUM instance to the Conn directory.
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3. Change the . rptdesign file contents to point to this connection profile location. (The following
example is from an OCUM instance that is installed in Linux; you should find equivalent
information for Windows.)

From
<property name="OdaConnProfileStorePath">Conn/ntap conn.acconprofiles</property>

To
<property
name="0OdaConnProfileStorePath">/opt/netapp/ocum/reports/Conn/ntap conn.acconprofiles</property>

4. To help confirm that the report gets connected by using the connection profile, you can remove
the following lines. These lines are optional, and BIRT uses them for a fallback mechanism if it is
unable to connect through the connection profile:

<property name="odaDriverClass">com.mysqgl.jdbc.Driver</property>

<property name="odaURL">jdbc:mysql://192.168.1.1:3306/ocum report</property>

<property name="odaUser">birtuser</property>

<encrypted-property name="odaPassword" encryptionID="base64">bmV0YXBwWMSE=</encrypted-property>

Note: For an IPv6 address, the database URL should be in the following format:

jdbc:mysql://address=(protocol=tcp) (host=£fd20:8ble:b255:8477:42f:
1lle:64e3:5338) (port=3306) /ocum_report

Where host=fd20:8ble:b255:8477:42f:11e:64e3:5338 is the host IPv6
address.

5. Now import the external . rptdesign file.

References

e NetApp OnCommand customer community in which users post questions and subject-matter
experts respond, and users can interact with peers

http://community.netapp.com/t5/OnCommand-Storage-Management-Software-Discussions/bd-
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Refer to the Interoperability Matrix Tool (IMT) on the NetApp Support site to validate that the exact
product and feature versions described in this document are supported for your specific environment. The
NetApp IMT defines the product components and versions that can be used to construct configurations
that are supported by NetApp. Specific results depend on each customer's installation in accordance with
published specifications.
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